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There are several options for acquiring IEQ sensors. If the 
research team does not have its own tools to deploy, a 
nearby university with an architecture or building science 
program, or even the local utility company, may have a tool-
lending or rental library. If the researchers have their own 
tools, it is important to prepare the sensors following the 
manufacturers’ instructions to calibrate them properly in 
advance of the study. Each sensor should also be labeled 
with a unique identifier, so it is easy to determine what tool 
was placed in which space, particularly for data download.

A team of individuals may be needed to help deploy the 
sensors, depending on the scale of the study. During a 
week-long study, one individual may be able to cover two 
schools, depending on their proximity to the schools. 
However, it often becomes challenging for one person to 
reach much more than two schools without disrupting the 
schools’ instructional hours. No matter how many assistants 
are involved, it is helpful to gather everyone together 
alongside the toolkits before the study begins to walk 
them through each step of the Training and Deployment 
Guide, found under the IEQ Replication Resources section, 
to ensure everyone knows how to prepare and deploy the 
tools properly.

Step 4: Prepare the schools for deployment
When coordinating data collection within schools, the 
research team should work with a person from each 
participating school to help identify typical classrooms 
and coordinate dates and access to the school for data 
collection. Before that happens, the research team 
should inform a broader school audience that the study is 
occurring. In particular, the team should communicate in 
advance with every teacher occupying each room selected 
for the study. A summary should be provided to these 
teachers, perhaps in an email sent by the school’s principal, 
which outlines the purpose of the study, the tools that will be 
deployed, and how it might impact them and their students. 
Involving the teachers is crucial to proper data collection; 
otherwise, sensors could be turned off, moved around the 
room, or even returned to the main office.

To minimize impact during school instructional hours, most 
of the tools selected for this study are data-logging, meaning 
they can be left unattended in a classroom and collect data 
over time. Typically, sensors are deployed outside of school 
hours, either before class begins in the morning or after 
school lets out in the afternoon. The data collector may have 

Replicating the Indoor Environmental Quality (IEQ) on-
site measurement portion of this study should consider 
the following.

Step 1: Determine the factors to measure
The first thing to do before beginning a study of IEQ is 
determine what factors are of interest. As was done for this 
study, it is recommended that the factors selected for study 
fall under the four main categories of IEQ: thermal comfort, 
air quality, acoustics, and daylight. Selecting factors within 
each category will depend on the available resources and 
technology, the level and length of access provided to the 
schools, who is available to assist with data collection, 
and what may be a priority interest to the school/district, 
themselves. For more information on the factors studied and 
tools used for this study, see the List of Sensors under the 
IEQ Replication Resources section.

Step 2: Identify spaces
Once it is known what is being studied, the next step 
is to determine where the IEQ factors will be studied. 
Deploying IEQ sensors across an entire school is oftentimes 
impractical and unnecessary. Akin to this study’s approach, 
the researchers recommend identifying a handful of “typical 
use” spaces to capture a sense of the schools’ average 
conditions. For more recommendations on this step, see 
the Sensor Location Selection document under the IEQ 
Replication Resources section.

Step 3: Prepare the toolkits and train people 
for deployment
Once the what and where are determined, the how and who 
can be planned. This is also the time for IEQ sensor 
identification and acquisition and the training of data 
collectors. Depending on the scope of study, a team could 
collect data within as little as one week with just a few 
sensors if the research takes place in one or two schools. 
But if the scope is larger, as with a district-wide study, more 
planning and greater detail is necessary to decide (1) the 
number of sensors needed and how many can be available 
at one time, and (2) how many weeks they need to be 
deployed to complete the data collection. If a multi-week 
study is necessary, establish a data normalization process 
to ensure that any exterior temperature variations during 
the data collection timeframe can be accounted for in the 
data tracking and analysis.
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to arrive at the school an hour or more before classes begin 
on the first day of the data collection period to successfully 
deploy all the sensors, which makes for an early morning. 
Thus, it is important to coordinate with each school’s point-
of-contact so the data collector can get into the building that 
early and gain access to the necessary spaces. 

Step 5: Deploy the tools
Once everything has been coordinated, the sensors can be 
deployed. Follow the Training and Deployment Guide under 
the IEQ Replication Resource section for more information.

During deployment, the researchers recommend the 
following for each room being studied.

• Make sure the researchers have coordinated with each
teacher who occupies that room. If the teacher(s) are
in the room when the sensors are being deployed,
make sure they understand the study and their
role in it.

• If the research team is interested in tracking
occupancy to more closely analyze the data, ask the
teachers in each room to complete an Occupancy
Tracker (available under the IEQ Replication
Resources section).

• Properly place the sensors, making note of which
sensors are being placed in which locations so the
data can be easily tracked after the fact.

• The researchers should also leave a business card
next to each sensor, alongside a document that
briefly outlines the study and what the sensors are
measuring. That way, if anyone has any questions, they
can call the research team directly.

• The sensors should be checked at least once each
day during deployment to ensure they are still working
as expected and that nothing has been moved or
unplugged. The team should coordinate the time and
access for this check-in before the study begins. In
some cases, they can arrange with someone at the
school to perform the check, such as a maintenance or
facilities supervisor, as long as that person is trained
in how to do it.

Step 6: Download data and analyze results
Once the data collection period is complete, collect all 
sensors and download the data to a central location. Each 
sensor will have a different interface, and ultimately there 
may be a variety of spreadsheets from each sensor. It is 
best to group the data by room and then aggregate the 
per-room data into one spreadsheet to create a summary 
(refer to the IEQ Replication Resources section for a sample 
data summary). Analysis of the data may involve things 
like separating and comparing data of occupied versus 
unoccupied conditions, averaging data, and visualizing 
information for easy comparison.

IEQ Replication Resources
To help replicate this study’s Indoor Environmental Quality 
on-site measurements, the following resources are 
available herein:

• IEQ — List of sensors
• IEQ — Training and deployment guide
• IEQ — Sensor location selection
• IEQ — Occupancy tracker
• IEQ — Sample data summary
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List of Sensors
Tools Used Unit of Measure

THERMAL COMFORT

Air Temperature HOBO MX1102A deg F

Humidity HOBO MX1102A % RH

Air Speed Degree Controls F350-omni with HOBO  
(UX120-006M) FPM

Mean Radiant  
Temperature

ping-pong with HOBO (UX120-006M) and  
external sensor (TMC6-HD) deg F

AIR QUALITY

CO2 HOBO MX1102A ppm

PM10/2.5 PurpleAir PA-II ug/m3

ACOUSTICS

dBA Tenma 72-947 dB

LIGHT

illuminance Extech EA33 footcandles

glare Manual phone app + grasshopper script  
for false color imagery lux ratio

NORMALIZATION

occupancy HOBO UX90-006 time

occupancy tracked by teacher See the Occupancy 
Tracker in Appendix C time

weather station HOBO U30 USB Weather Station Starter Kit, 
2-meter tripod, PurpleAir PA-II

 deg F, % RH, MPH, 
ug/m3 
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Training and Deployment Guide

1 | IEQ Measurement Guide

The night before you begin a study, complete the following: 
• Calibrate the HOBO MX1102A
• Launch the HOBO MX1102A, HOBO UX90-006, and HOBO Data Logger by setting them to

a Delayed Start
• Verify that the batteries in the Tenma have been fully charged and have the correct time. 

When you place your sensors at the beginning of every week, please complete your worksheet to 
locate which sensor was placed in which room for the duration of the study.  

You will be using the following sensors to study data in the below spaces in each school: 
• Classroom 1

o HOBO MX1102A (CO2, temperature, humidity) 
o Tenma 72-947 (dBA) 
o Mounted to tripod:

- PurpleAir PA-II SD (PM 2.5/10)
- HOBO data logger + grey globe + anemometer (Mean Radiant Temperature +

Air Speed)
• Classroom 2

o HOBO MX1102A (CO2, temperature, humidity) 
o Tenma 72-947 (dBA) 

• Classroom 3
o HOBO MX1102A (CO2, temperature, humidity) 
o Tenma 72-947 (dBA) 

• Classroom 4
o HOBO MX1102A (CO2, temperature, humidity) 
o Tenma 72-947 (dBA) 

• Cafeteria
o HOBO MX1102A (CO2, temperature, humidity) 
o Tenma 72-947 (dBA) 
o HOBO UX90-006 (occupancy)
o Please note that for the cafeteria, the occupancy tracker should be mounted to the 

wall (see instructions for more details), but the CO2 and Sound Meter should be 
placed in a location that is controllable by teachers. This will need to be determined 
on a case-by-case basis, and may not always be the “Ideal” placement as laid out in 
the instructions below. Please note the location of these devices on a floor plan for 
future reference. The priority is to ensure that these devices will not be disturbed 
during the length of the study. 

You will be given a card for each room to explain the sensors and the study. Please make sure to 
locate this near the sensors, along with your business card.  

AAiirr  TTeemmppeerraattuurree//HHuummiiddiittyy//CCOO22  ––  HHOOBBOO  MMXX11110022AA  
A complete user manual for this logger can be found here: 
https://www.onsetcomp.com/resources/documentation/22504-mx1102a-manual

The following are PE’s recommended steps for setting up this logger: 
• Download HOBOconnect from the app store onto your phone or tablet
• Ensure that batteries are installed in the logger. Open the battery door on the back of the

logger and insert four AA batteries if needed. 

5 Addressing a Multi-Billion Dollar Challenge | Study Replication Resources

https://www.onsetcomp.com/resources/documentation/22504-mx1102a-manual
https://www.onsetcomp.com/products/software/hoboconnect


2 | IEQ Measurement Guide

SSTTEEPP  11  ––  CCAALLIIBBRRAATTEE  TTHHEE  DDEEVVIICCEE  ((sshhoouulldd  ooccccuurr  tthhee  nniigghhtt  bbeeffoorree  tthhee  ssttuuddyy))  
• Open HOBOmobile. Enable Bluetooth in your device settings if prompted. Bluetooth must 

be enabled on your device and in range for setup.
• In HOBOmobile, tap the HOBOs icon in the bottom left. The logger should appear in the In 

Range list.

• Tap the row in the In Range list associated with the logger number found on the bottom of
the device to connect to the logger. 

• Once connected, tap Configure to set up and start the logger.

• Choose the following logger settings: Set logging interval to 10 minutes, set the Start 
Logging time to Now, and set Stop Logging to When memory fill or On button push.

• Click Start at the top of the screen to deploy the logger.
• Once deployed, take logger to an empty room or outdoors to leave for calibration.
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• Press and hold the “Calibrate” button at the right of the bottom of the screen until you 
hear a loud beep. Release the button.

• Leave the logger in place until calibration completes, about 5-10 minutes. Step out of the
room to ensure your breath does not affect the calibration. 

• Once calibration is complete, you will no longer see the “Calibrate” flashing in the bottom
right, and the numbers on the screen will not be changing as quickly. Stop the logger by 
pressing and holding the bottom left button until the logger has been stopped.

• Proceed to launching the device after calibration is complete. 

SSTTEEPP  22  ––  LLAAUUNNCCHH  TTHHEE  DDEEVVIICCEE  ((sshhoouulldd  ooccccuurr  tthhee  nniigghhtt  bbeeffoorree  tthhee  ssttuuddyy))  
• Open HOBOmobile. Enable Bluetooth in your device settings if prompted. Bluetooth must 

be enabled on your device and in range for setup.
• In HOBOmobile, tap the HOBOs icon in the bottom left. The logger should appear in the In 

Range list.

• Tap the row in the In Range list associated with the logger number found on the bottom of
the device to connect to the logger. 
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• Once connected, tap Configure to set up and start the logger.

• Choose the following logger settings: Set logging interval to 10 minutes, set the Start 
Logging time to be when you expect to deploy the sensors on your first day of testing, and 
set Stop Logging to When memory fill or On button push.

• Click Start at the top of the screen to deploy the logger.

SSTTEEPP  33  ––  PPLLAACCEE  TTHHEE  HHOOBBOO  
• On your worksheet, make a note of which room the HOBO is being placed in for the study. 
• Place HOBO in data-collection location. Sensors should be placed face up or out so as not 

to block the sensing locations on the device. Place the sensor within the breathing zone 
(3 ft – 6 ft), away from HVAC equipment, away from windows, and in an area it will not be 
disturbed by occupants whenever possible. For example, a good location in a classroom 
is generally on the teacher’s desk. 
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SSTTEEPP  44  ––  UUNNLLOOAADD  TTHHEE  DDAATTAA  
• To Stop deployment, hold down the bottom left button on the reader until the screen says 

STOP.

• To offload data from the logger, return back to the HOBOmobile app, connect to the
logger, and tap Readout. The data from the logger will be saved to your device.

• Tap the Data Files icon at the bottom of the screen and then tap the mini-graph to view a
larger version of the graph.
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• Tap to export the data to an excel file and e-mail the data to yourself. 

• Tag this data file with the following criteria: TTeemmpp__SSCCHHOOOOLL  NNAAMMEE__RROOOOMM  NNuummbbeerr..xxllssxx,
and store it in the project folder.
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IInnddoooorr  AAiirr  QQuuaalliittyy  TTrriippoodd  

The Indoor Air Quality Tripod has 4 sensors mounted on it: Air Velocity, Mean Radiant Temperature, 
Particulate Matters (PM Meter), and Data Logging. A more detailed explanation for each of the devices 
will be given below. For setting up the tripod, there are two possible configurations: Deployed Mode, 
and Compact Mode, which can be adjusted by screwing and unscrewing the black screws in between 
the metal tubes.  

• The Compact mode, should be used when carrying the tripod to the site and from the site, 
and it should look like this:

• Please protect the sensors at the top when transporting
• The Deployed Mode is used when the sensors are tracking any data, and should look like

the image below 
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• Make sure that every time you collapse or deploy the tripod, you use the black screw to 
tighten the metal tubes (there might be sensors attached to these black screws; it is OK 
to twist the black tubes with the sensors attached to them). DO NOT TWIST THE METAL 
TUBES at the moment of deploying or collapsing the tripod:

• The only cable you are going to need to plug into the sensors is the PM Meter’s power 
chord. Please make sure to connect this cable once the tripod has been deployed, and 
unplug it before collapsing it.

Mean Radiant Temperature and 
Air Velocity Location 

PM Sensor 

Data Logger 
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PPMM  1100//22..55  ––  PPuurrpplleeAAiirr  PPAA--IIII  SSDD  

This sensor is attached onto a tripod with a series of other loggers. This tripod should be located out of 
the way of classroom activity to avoid interference by students, but also away from windows, doors, 
and diffusers whenever possible.  
Please communicate to the teacher that this device should remain plugged into the wall AT ALL TIMES 
during the study.  

The following are PE’s recommended steps for setting up this logger: 

SSTTEEPP  11  ––  LLAAUUNNCCHH  TTHHEE  DDEEVVIICCEE  
• Plug the power block into a functioning wall outlet.
• A blue and green light seen from the top of the sensor indicates the sensor is starting.

• After 10-15 seconds both lights should turn off and will begin to glow the current AQI color 
shortly. Make sure the blue LED light next to the SD card flickers from time to time 
(approximately every 2 minutes) 

Chord is supposed to be 
connected to PM sensor after 

deployment and before collapsing 
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SSTTEEPP  22  ––  UUNNLLOOAADD  TTHHEE  DDAATTAA  
• To stop the device, all you need to do is unplug it from the wall.
• To unload the data, utilize the tweezers to remove the microSD card from the device.

• Connect the SD card into your SD card reader, and plug into your computer. Once connected, 
locate the CSV files on the device. Tag this data file with the following criteria: PPMM  __SSCCHHOOOOLL
NNAAMMEE__RROOOOMM  NNuummbbeerr..ccssvv, and store it in the project folder.

Red Glow 
Showing Air 
Quality Index 

SD Card 
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• After data has been downloaded in this location, please notify the Sustainability Team for 
review.

• After data review has been completed, please delete the content of the SD card, and reinsert
the SD card into the slot in preparation for the next launch. To reinsert the SD card properly, 
the logo should face toward the outside of the device and the magnetic contacts face inside 
toward the sensors, or up as shown in the image below.

Insert SD Card 
into the card 
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AAiirr  SSppeeeedd  ––  DDeeggrreeee  CCoonnttrroollss  FF335500--oommnnii  

• This sensor is attached onto a tripod with a series of other loggers. This tripod should be located out of
the way of classroom activity to avoid interference by students, but also away from windows, doors, 
and diffusers whenever possible. 

• For setup, please ensure that this sensor is plugged in to the #1 and #2 channels of the HOBO data 
logger and follow the instructions under Mean Radiant Temperature to ensure that device is properly 
launched and connected.

• The sensor head is an omni-directional air speed sensor. This means it can be installed to face any 
orientation and pick up air speeds from any direction. However, the inside of the head is very 
sensitive, so please be careful during transport and placement to not damage this sensor. 

MMeeaann  RRaaddiiaanntt  TTeemmppeerraattuurree  ––  HHOOBBOO  DDaattaa  LLooggggeerr  wwiitthh  GGrreeyy  GGlloobbee  

• This sensor is attached onto a tripod with a series of other loggers. This tripod should be located out of
the way of classroom activity to avoid interference by students, but also away from windows, doors, 
and diffusers whenever possible. 

• Please communicate to the teacher that this device should remain plugged into the wall AT ALL TIMES 
during the study. 

• A complete user manual can be found here: https://www.onsetcomp.com/files/manual_pdfs/17384-
E%20UX120-006M%20Manual.pdf

The following are PE’s recommended steps for setting up this logger:

SSTTEEPP  11  ––  LLAAUUNNCCHH  TTHHEE  DDEEVVIICCEE  ((SShhoouulldd  ooccccuurr  tthhee  nniigghhtt  bbeeffoorree  tthhee  ssttuuddyy))  
• Connect the HOBO Data Logger to your computer using the USB cable. 
• Open HOBOware
• If you see the HOBO information in the bottom left corner of the HOBOware screen, you will know

that the device has been recognized by the software and you can proceed with the launch. 

• Click the “Launch” button at the top of the screen.

• Under the “Sensors” section, select the first three sensors and label as follows. Sensors 1 and 3
can be found under Temperature, and Sensor 2 can be found under Air Velocity.
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• Under “Deployment”, set the logging interval to 10 minutes. Set the Start Logging to On 
Date/Time, and select the time that you plan to start the study the following day. Under Stop
Logging, select When Memory Fills and Push Button.

• Once complete, press Delayed Start at the bottom right to launch the device. 

SSTTEEPP  22  --  PPLLAACCEE  TTHHEE  DDEEVVIICCEE  
• The device is mounted to a tripod, which should be set up on the edge of a classroom, out of the 

way from activity to avoid interference by students. Behind the teachers desk may be an 
appropriate location. Please try to play away from the windows, door, and/or directly underneath a
diffuser whenever possible. 

• Once the tripod is in place, make sure that both plugs are plugged into the wall and tape down 
wires as necessary. 

• If the teacher is there, please inform them that this tripod should remain plugged in during the
entire length of the study!

SSTTEEPP  33  ––  SSTTOOPP  TTHHEE  DDEEVVIICCEE  
• To stop the device, press and hold the top left button on the device until STOP appears across the

screen.

. 
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SSTTEEPP  44  ––  DDOOWWNNLLOOAADD  TTHHEE  DDAATTAA  
• To download the data, reconnect the HOBO Data Logger to your computer and open HOBOware. 

• Once the device has been recognized, select the Readout device button at the top left of the
screen.

• Locally save the HOBO file to continue. 
• A Plot Setup screen will appear. Make sure the three data points are properly identified – Air

Temp, Air Speed, and Mean Radiant Temp. At the bottom of the screen, select Plot. 

• The data will then plot out onto the screen. 
• Select File > Export Table Data, and click Export.
• Save this data file with the following criteria: TThheerrmmaall  CCoommffoorrtt  __SSCCHHOOOOLL  NNAAMMEE__RROOOOMM

NNuummbbeerr..ccssvv, and store it in the project folder.
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ddBBAA  ––  TTeennmmaa  7722--994477  
A complete user manual can be found here: 
http://www.farnell.com/datasheets/1842860.pdf?_ga=2.129813132.1086292094.1517276643-
259333521.1517276643  

The following are PE’s recommended steps for setting up this logger: 

SSTTEEPP  11  ––  PPLLAACCEE  TTHHEE  SSOOUUNNDD  MMEETTEERR  
• On your worksheet, make a note of which room the sound meter is being placed in for the study. 
• The sound meter is battery powered. Please make sure to charge and replace the batteries in the

sound meter every day.

SSTTEEPP  22  ––  LLAAUUNNCCHH  TTHHEE  DDEEVVIICCEE  
• First, turn on the device by pressing the bottom right power button. 
• Above the dBA reading, verify that the device is set to the correct time. If the time is correct, 

please proceed to the next bullet. If not, follow the sub-bullets below to correct the time. 

• TO CHANGE THE TIME, Press and hold the “Setup” button and then press the yellow power button 
for ~2 seconds. Release both buttons.

• You should see Time flash on the screen, and then the following screen. Press the “Setup” button 
to advance to the next screen. 

• The next screen should show numbers and nn on the bottom. The numbers represent minutes. 
Press the “Level” button until the screen reads the appropriate time in minutes. Once there, press 
the “Setup” button to advance to the next screen.
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• The next screen shows a number at the top and h – A or P. This represents the hours in AM or PM. 
Press the “Level” button until the screen reads the appropriate time in hours, and keep scrolling
to make sure that AM/PM matches. Once there, press the “Setup” button to advance to the next 
screen.

• The next screen shows the date. Press the “Level” button until the screen reads the appropriate 
day of the month. Once there, press the “Setup” button to advance to the next screen.

• The next screen shows the month. Press the “Level” button until the screen reads the appropriate
month of the year. Once there, press the “Setup” button to advance to the next screen.

• The next screen shows the year. Press the “Level” button until the screen reads the appropriate
year. Once there, press the “Setup” button to advance to the next screen.

• The next screen says Reset. To confirm the settings, press the “Setup” button one last time to
advance to the final screen.
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• The final screen should show the appropriate date as you have entered, YR – MO – DAY.
Press the “Hold” button to lock these settings and return to the main screen. 

• The main screen should now show the appropriate time just above the dBA reading. Once
complete, power the device off by holding the yellow power button for 3 seconds.

• ONCE YOU HAVE CONFIRMED THE TIME IS CORRECT, Press and hold the “Light bulb” button 
and then press the yellow power button for ~2 seconds. Release both buttons.

• Set interval to desired number of seconds (45) using the “LEVEL” button. Press “HOLD” 
button when finished.
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• Use the “LEVEL” button to change the decibel range. Choose “30-130” as range. Confirm that 
the small clock icon does not appear in the lower lefthand corner of the screen. If the icon 
appears, press the “Setup” button to disable the automatic power off feature.

• Press the “REC” button once to start the recording. “REC” should appear in the bottom right 
corner of the screen. Meter is ready to collect data.
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SSTTEEPP  33  ––  DDAATTAA  CCOOLLLLEECCTTIIOONN  PPEERRIIOODD  

• While data collection is occurring, return to the device each day to ensure data is still collecting. At 
this time, press and hold the power button for 3 seconds to turn off the sound meter. This will log 
the data collected during the previous day.

• Once the meter is off, please replace the battery with a freshly charged reusable battery.
• Repeat Step 2 to relaunch the device for a new day of data collection.

SSTTEEPP  44  ––  UUNNLLOOAADD  TTHHEE  DDAATTAA  

• At the end of the data collection period, you must press and hold the power button to turn off the
sound meter BBEEFFOORREE removing the batteries or data will not save. 

• To unload the data, connect the sound meter via USB to your computer, turn on the Sound Meter,
open the Sound Level Meter application, and click the Setup button on the meter to connect. 

• Press the Datalogger (D) button.

• Select (doubleclick) the datapoints that match up with your recording time period (there should be
3-4 different data files from your week of study, depending upon how many times the sound meter 
was restarted) and click Save Data to export a .txt file. 
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• Open the .txt file in notepad and delete the first row – the header information
• The .txt file can then be imported into excel for analysis by opening Excel, selecting the Data tab, 

Get Data, From File, From Text/CSV. Select your .txt file when prompted.
• The pop-up window will prompt you how to read the text file. Select “Comma” as you Delimiter,

and the data should separate into individual columns showing Date, Time, dBA reading, and unit 
respectively.

• Tag this data file with the following criteria: SSoouunndd__SSCCHHOOOOLL  NNAAMMEE__RROOOOMM  NNuummbbeerr__DDAATTEE  ooff
rreeccoorrddiinngg..ccssvv, and store it in the project folder.

• After data review has been completed, please clear the sound meter by holding the “REC” button 
and then press the yellow power button for ~2 seconds until the screen says CLR. This means the
device has been successfully cleared, and you can release both buttons.

OOccccuuppaannccyy  ––  HHOOBBOO  UUXX9900--000066  
A complete user manual can be found here: https://www.onsetcomp.com/files/manual_pdfs/15433-
H%20UX90-005%26006%20Manual.pdf 

The following are PE’s recommended steps for setting up this logger: 

SSTTEEPP  11  ––  LLAAUUNNCCHH  TTHHEE  DDEEVVIICCEE  ((sshhoouulldd  ooccccuurr  bbeeffoorree  rroooomm  ppllaacceemmeenntt))  
• Connect the sensor to your computer with USB cable and open Hoboware 
• You can Download and install HOBOWare by clicking in the following link

https://www.onsetcomp.com/products/software/hoboware 
• Click the Launch icon on the HOBOware toolbar

• In the Configure Sensors to Log, make sure that Light and Occupancy are set to State. In the “% or
Time” Column, make sure Light is set to “off/on” and Occupancy is set to “unoccupied/occupied”
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• For Start Logging, Select the “On Date/Time” option, and select the time that you plan to start the
study the following day. For Stop Logging, make sure “When memory fills” and “Push Button” are 
selected.

• Launch the logger by clicking on the Delayed Start option at the bottom right. 

SSTTEEPP  22  ––  PPLLAACCEE  TTHHEE  DDEEVVIICCEE  
• The logger will be placed in a cafeteria and has a detection area of 45’ X 38’. Make sure you place

the logger approximately in the middle of the longer side of the room (as shown in the image 
below).

• Make sure to place the logger in a place where it is out of reach of (approximately 8’- 9’ above
floor level). Consider using a ladder or a chair to place the logger on the wall.

• The sensor has 4 magnets on the back that can easily attach to any metallic surface. If there is no
metallic surface you can attach the sensor to, please use a command tab to mount the device to 
an appropriate surface.
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SSTTEEPP  33  ––  SSTTOOPP  TTHHEE  DDEEVVIICCEE  
• At the moment of picking up the sensor, press and hold the Stop logging button at the top left of 

the device for 3 seconds. A STOP sign will appear in the screen of the device, which means data is 
not being recorded anymore.

Place the logger 
 

Stop Button 
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SSTTEEPP  44  ––  DDOOWWNNLLOOAADDIINNGG  TTHHEE  DDAATTAA  
• Connect the sensor to your computer with USB cable and open 

Hoboware. Click on the Readout button. 

• Locally save the HOBO file to continue. 
• A Plot Setup screen will appear. Make sure the two data points are

properly identified – Light and Occupancy. At the bottom of the 
screen, select Plot. 

• The data will then plot out onto the screen. 
• Select File > Export Table Data, and click Export. 
• Save this data file with the following criteria: OOccccuuppaannccyy  __SSCCHHOOOOLL

NNAAMMEE__CCaaffeetteerriiaa..ccssvv, and store it in the project folder.

27 Addressing a Multi-Billion Dollar Challenge | Study Replication Resources



24 | IEQ Measurement Guide

OOccccuuppaannccyy  ––  TTrraacckkeedd  bbyy  TTeeaacchheerr  
At the beginning of each week, please give an occupancy tracker worksheet to each teacher (of 
the 4 classrooms studied) and ask them to track when the classroom was in use throughout the 
4-day study period and when it wasn’t.  
At the end of the 4-day collection period, make sure to collect this completed occupancy sheet 
from the teacher.  
Scan these sheets and rename the files with the following criteria: Occupany_SCHOOL 
NAME_ROOM NUMBER.pdf, and store it in the project folder. 

II lllluummiinnaannccee  ––  EExxtteecchh  EEAA3333  
A complete user manual can be found here: https://flir.netx.net/file/asset/49036/original  
The following are PE’s recommended steps for using this tool: 

SSTTEEPP  11::    SSEETTTTIINNGG  UUPP  TTHHEE  SSTTUUDDYY  
• Measurements should be taken in all of the studied rooms twice – once in the morning (between 

10-11AM) and once in the afternoon (between 1-2 PM). 
• Measurements should be taken on a grid throughout the classroom every 5’, as shown below. 

• Identify your rooms in the floorplans, and make sure to note the room number, draw important 
features like windows and door locations, and note what time you are conducting the 
measurements and the current outdoor daylight conditions (Cloudy, Partly Cloudy, Sunny)

• 5’ can be measured “roughly” using your feet or using guides such as floor or ceiling tiles. 
• For the first round, please open all blinds, turn off all lights, and shut doors into the hallway to 

avoid capturing electric lighting – we are trying to solely capture the daylight conditions. If there is 
emergency lighting that cannot be turned off that is interfering with measurements, make a note 
of it on your plan. For the second round, keep all blinds open and doors closed, but turn on 
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electric lights and reconduct the measurements to study the impact of both daylight + electric 
lighting on the space. 

SSTTEEPP  22::  CCAAPPTTUURRIINNGG  TTHHEE  DDAATTAA  

• Turn on light meter using the orange button and remove the black cover from the sensor. 

• Confirm that the units on the device are being measured in FC (footcandles) instead of LUX by 
pressing the bottom right button.

• Measurements will be taken from the white bulb on the sensor, and should be taken at roughly 
desk height. Please bend down at each measurement to make sure that you are not casting a
shadow on the light sensor. 

• Hold the light sensor over your head, flat with the sensor facing the ceiling. Make sure your fingers 
are not blocking the light sensor as you hold it.

• Once bent down and holding the sensor in the proper location, press the H button at the top right 
to hold the measurement reading. Record this number on your gridded plan and move on to the 
next point in the grid. 

• Press the “H” button again to return to live measurements.
• Scan these sheets, and rename the files with the following criteria: DDaayylliigghhtt__SSCCHHOOOOLL

NNAAMMEE__RROOOOMM  NNUUMMBBEERR__mmoorrnniinngg//aafftteerrnnoooonn..ppddff, and store it in the project folder.
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GGllaarree  ––  CCaammeerraa  

FOR IPHONES: 
• Open the Manual App (https://itunes.apple.com/us/app/manual-raw-custom-exposure-

camera/id917146276?mt=8) or just search for “Manual Raw Camera” in the app store, and 
download the first option that shows up.

• Once you open the App make sure to open the settings, on the top right corner of your screen 

• Under Settings at the top right, make sure that the
“Save Compressed with RAW” button is on.

• Select JPEG as your Processed Format 
• Select Thirds as your Grid Option 
• Turn Off Level
• Make sure Histogram, Sound, and Haptics are ON
• At the bottom left of the screen, ensure that the 

camera is in Manual Mode by clicking the “AUTO”
button until the rectangle is no longer colored.

• At the bottom mid of the screen, Alter the ISO to 58,
by swiping up or down.

• At the bottom right of the screen, Alter the Shutter 
Speed (S) to 1/60.

• At the top left of the screen, ensure that the camera
is in Raw Mode by clicking the “RAW” button until 
the rectangle is no longer colored.

• Please leave these settings consistent for EVERY
space that you photograph. 

• For the first photos, please turn off all lights and 
shut doors into the hallway to avoid capturing 
electric lighting and solely capture daylight 
conditions.

• Once all the settings are in place, stand in the 
middle of the classroom and face an outside corner 
of the classroom, with the corner in the center of the
shot, as shown in the image below. Rotate to the 
other outside corner, and take a second photo.

• Then, turn on the lights and repeat.
• Please keep track of which photos were taken in 

which classrooms in which school!
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• Send these photos to your e-mail, and rename the images as GGllaarree__SSCCHHOOOOLL  NNAAMMEE__RROOOOMM
NNUUMMBBEERR__mmoorrnniinngg//aafftteerrnnoooonn__RR//LL, and store it in the project folder.

FOR ANDROIDS: 
• Open the ProShot App 

(https://play.google.com/store/apps/details?id=com.riseupgames.proshot2&hl=en_US)
• Once you open the App, open the settings on the top right corner of your screen

• Tap JPEG at the upper right until it says RAW+JPEG
• Keep the other settings as shown above
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• Touch the screen to return to the main view
• Make sure the bottom left of the screen shows a

rectangle – meaning it is in Normal mode
• Make sure the bottom right of the screen shows 

an M – meaning it is in Manual mode. 
• Set ISO to 55, Maintain Auto for WB, and Select 

1/60 for Shutter Speed
• Images will be stored under you Photos as both 

a RAW file and a JPEG. Please save both to the 
folder

• Please leave these settings consistent for EVERY 
space that you photograph. 

• For the first photos, please turn off all lights and 
shut doors into the hallway to avoid capturing 
electric lighting and solely capture daylight 
conditions.

• Once all the settings are in place, stand in the 
middle of the classroom and face an outside 
corner of the classroom, with the corner in the 
center of the shot, as shown in the image above, 
in the iPhone section. Make sure to take the 
photo in landscape instead of in portrait. Rotate 
to the other outside corner, and take a second 
photo.

• Then, turn on the lights and repeat.
• Please keep track of which photos were taken in 

which classrooms in which school!
• Send these photos to your e-mail, and rename 

the images as GGllaarree__SSCCHHOOOOLL  NNAAMMEE__RROOOOMM
NNUUMMBBEERR__mmoorrnniinngg//aafftteerrnnoooonn__RR//LL, and store it in the project folder.
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To select the spaces that were sampled in each 
school, the researchers used the following 
procedure:  

• First, to represent typical learning
environments, the researchers identified all
the classrooms within a school dedicated to
core-learning. Spaces like science labs, art
rooms, and small group areas were excluded
in order to focus on the typical core-learning
environments.

• To determine the number of classrooms to
be studied in each school, the researchers
aggregated the total number of core-learning
spaces found in all the modernized schools
vs. all the non-modernized schools, and
targeted a 95% confidence level and 10%
margin of error. From this assessment,
the researchers determined that four
classrooms in each school would be studied.

• The floor plans of each school were then
evaluated to identify the core-learning
classrooms, which were then further broken
down by cardinal orientation (N/S/E/W)
and by floor level. The percentage of rooms
facing each orientation, and on each floor,
determined how the selected four rooms
would be distributed within that school.
Then, the most centrally located typical
classroom for each orientation/floor was
identified. Once the classrooms were
identified based on the floor plans, they then
were confirmed with the school to ensure:
the rooms were utilized; they were used for
core learning; the rooms’ teachers would be
amenable to participating in the study; and
the classrooms would be regularly occupied
during the study period. For any classroom
that did not conform to these criteria, an
alternate classroom was selected that did
meet these requirements.

• In addition to four classrooms per school,
the researchers decided to also study a
communal/shared space in each school.
The researchers identified the cafeteria as
the communal space to study in each school
as it was a space that could be found and
would remain relatively consistent across
each school in the sample. A common space
was selected because, at some point in
the day, everyone in the school would have
access to it, and it may have a higher risk of
poor performance due to its size, ability to
be maintained, occupancy, etc.

Sensor Location Selection
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Sample Data Summary

Average % of time OUTSIDE the comfort zone 72%

Average temperature swings (°F) 7.5

Lowest temperature (°F) 64.7

Highest temperature (°F) 80.4

Average CO2 levels (ppm) 779.6

Lowest CO2 reading (ppm) 401

Highest CO2 reading (ppm) 1669

Average Ambient Noise level (dB) 38.8

Average Occupied Noise level (dB) 48.1

Highest Occupied Noise level (dB) 87.8

Average %age Overlit Floor Area - Daylight only 0%

Average %age Underlit Floor Area - Daylight Only 98%

Average %age Overlit Floor Area - Electric + Daylight 0%

Average %age Underlit Floor Area - Electric + Daylight 25%

TTHHEERRMMAALL  CCOOMMFFOORRTT

AAIIRR  QQUUAALLIITTYY

AACCOOUUSSTTIICCSS

DDAAYYLLIIGGHHTT

35 Addressing a Multi-Billion Dollar Challenge | Study Replication Resources



CONTACT USCONTACT US
We welcome further inquiry about the study and how to apply the findings to the modernization of schools.

Co-Principal Investigator,
Educational Adequacy/Primary and 
Secondary Education Design Lead

Sean O’Donnell FAIA, LEED AP
Principal, Perkins Eastman

s.odonnell@perkinseastman.com

Co-Principal Investigator, 
Community Connectivity/School 

Dynamics Lead
Bruce Levine JD

Clinical Professor and Director of 
Educational Policy Program, School of 

Education, Drexel University
bl63@drexel.edu

Indoor Environmental Quality/
Sustainability Lead

Heather Jauregui AIA, LEED AP 
BD+C, O+M, CPHC

Director of Sustainability and 
Associate Principal, Perkins Eastman

h.jauregui@perkinseastman.com

Research Lead
Emily Chmielewski EDAC

Design Research Director and Senior 
Associate, Perkins Eastman

e.chmielewski@perkinseastman.com

Project Manager
Karen Gioconda NCIDQ, 

LEED AP, ID+C
Associate Principal, Perkins Eastman
k.gioconda@perkinseastman-dc.com

Statistician
Lance Kruse PhD

CEO, Invontics
www.invontics.com
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